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1 – Introduction 

 
This document describes new and improved features in the Dapresy Pro 2018 January-February Release. 

If you would like to know more about these features, please contact Dapresy Global Support at: 

support@dapresy.com and they will be able to assist you. 

Best Regards, 

Dapresy Team 

 

Email:  support@dapresy.com 

  

http://www.dapresy.com/
mailto:support@dapresy.com
mailto:support@dapresy.com


 

www.dapresy.com  Technical Release Notes Dapresy Pro 2018 January-February Release Page 5 of 42 

 

2 - Overview 
The Dapresy Pro 2018 February update contains many great improvements, which you can see in the 

summary list slightly further down. Some of these key improvements are the new Ranking calculation in 

Storyteller tables and new support for using the effective base size in the significance test calculations.  

Many of the improvements in Storyteller table area allows creation of more advanced tables in terms of 

both layout and content as more settings can be made per series like for example formatting rules and 

intervals, instead of the applying the settings to the whole table. 

The list below shows the new features divided into different areas. 

Data import 

 Silverlight has been removed so no browser plugins are needed to import data or setup import 

schedules 

 New, more user-friendly, layout including more visual error and information messages 

 Much better performance in the meta data transformation, speed is great even with ten 

thousands of questions and answers 

Storyteller Tables 

 New ability to add Rank numbers  

 New ability to merge series by the row text 

 New ability to set the Formatting rules per series 

 New ability to set the Time interval and Moving average per series 

 New ability to define custom row and column headers 

 Improved layout settings, minimum column width and vertical text alignment 

 New Hierarchical filter option to show all groups  in the same level 

Storyteller Charts 

 New padding setting in Data labels 

 Improved Solid Gauge when negative scale is used, set start point to 0 

 Ability to turn the Magnifying glass on and off 

 New ability to set the Time interval and Moving average per series 

 New Hierarchical filter option to show all groups  in the same level 

Storyteller Respondent data tables 

 New support for displaying photos, links etc. 

 Ability to turn the Excel export and Full Screen mode off 

 Ability to set vertical text alignment 

http://www.dapresy.com/
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Storyteller setup 

 New support for Arrange, Distribute and Align object Groups  

 New support for Arrange slides in the slide navigation tool 

Significance tests in Storyteller charts and tables and Cross table tool 2.0  

 Support for using the effective base size 

Template library 

 Improved chart wizard, layout options has been added to the wizard for simplifying the creation 

of the charts 

Respondent based Event server 

 Limiting number of alerts in the Respondent based Event emails 
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3 Data import 
The data import pages have been updated with a new modern look and feel which is more use-friendly, 

displays error and information messages more clear and the Meta data transformation is faster even 

with ten thousands of questions and answers. The new pages are not using Silverlight as most of the 

browsers do no longer support that so no browser plugins are needed to import data.  

The overall logic (workflow and controls) are the same as before so no additional education is needed. 
Also, logic and rules of the needed formats and validation of meta and case data remains the same as 
before so no changes has been done in that area.  
 

3.1 Manual data import 

The image below shows the new import screen for manual imports. It shows the different steps in the 

import process when importing both meta and case data. As shown the blue information boxes inform 

what to do as next step.  

The image below shows the layout of the different steps in the new Data import screen. 
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3.1.2 Meta Data Transformation 

The image below shows the new layout in the Meta data transformation. The functionality and logic is 

same as before but the speed is much faster and that is especially noticeable when ten thousands of 

questions and answers are being loaded. 

The image below shows the new layout in the Meta data transformation tool. 

 

Note: new dropdown filters have been added to the column headers which makes it easier to for 

example find the errors as shown in the image below. 

The image below shows how all errors easily can be found with the new dropdown filters. 
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3.2 Import schedule page 

The image below shows the new layout in the Import scheduler page. The functionality and logic is same 

as before but controls that cannot be used are hidden until these are valid to use which makes the 

interface more user-friendly.  

The image below shows the new layout in the Import scheduler page. 
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4 – Storyteller table improvements 
The following improvements have been done in the Storyteller tables:  

 New ability to add Rank numbers  

 New ability to merge series by the row text 

 New ability to set the formatting rules per series 

 New ability to set the time interval and moving average per series 

 New ability to define custom row and column headers 

 Improved layout settings, minimum column width and vertical text alignment 

 New Hierarchical filter option to show all groups  in the same level 

 

4.1 Rank 

A new rank calculation has been added to the Storyteller tables. The rank can be based on any 

calculation type: mean values, percentage shares, count etc.  

Here we have three examples of showing rank in a table. The rank can be displayed on its own or 

together with the original values. 

 

As well as showing the rank of all items in the table, as in the examples above, it is also possible to show 

the rank for a specific selection, based on the choice made in the optional filter area (for instance a 

brand, a campaign, a unit in the hierarchical structure etc.) even if the other values are not shown in the 

table. This is very useful when a user would like to be able to see the rank of his/her unit/brand but not 

the others. 

4.1.1 Setup 

The rank setup is made in a new panel named Rank, it is in the Analysis tab. The setup of the Rank is very 

similar to the setup of the Benchmark calculation. The following steps are made: 

 Select if the Rank values shall be shown only or if the Rank values shall be shown together with 

the calculated result  
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 Select if the Rank shall be made across Columns or Across rows   

 Select if the Rank shall be made in a certain sub group or across all items (all rows or all 

columns) 

 Select if the Rank shall be shown for a specific item based on Optional filter selection  

The image below shows the Rank setup panel, each of the settings is described further down. 

 

Show only Rank  

With the “Show only rank values” setting you define if the Rank values shall be shown standalone or 

together with the result. If the setting is active the Rank values are shown standalone, if it is deactivated 

both the result and rank values are shown. 

The image below shows two examples, the table to the left displays both the rank and result and the 

table to the right display rank values only. 
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Dimension 

In the Dimension list you define if the rank shall be made across columns or across rows, see examples 

below. 

In the left table below the rank is made across columns, in the right table the rank is made across rows. 

 

Rank object 

In the Rank object list you define if the rank shall be made across all rows/columns or if it shall be made 

within a specific object such as an Interval, Filter compare, Question etc. In the example below the table 

shows Interval and Regions in columns. In this case the rank can be made across all columns, within the 

Regions or within the months. 

In the left table below the rank is made across all columns, in the right table it is made within Regions.  
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Show rank in same row or in new row 

Select if the rank shall be shown in same row or in a new row, see examples below. This option is not 

available when only the rank values are shown in the table. 

The table to the left shows the rank values in the same row, the table to the right shows the rank values 

in a new row.

 

 

Show rank for specific item based on Optional filters 

This function is used to only display the rank of a specific item selected in the Optional filter area, it 

could be a Hierarchical Filter, Variable subset or a Filter.  This option is useful when the user for example 

not is allowed to see the rank of competitors or other hierarchical filter groups. 

The image below shows a typical example, the report shows the result for the selected campaign in the 

“Campaign” filter but all campaigns have been used as a base for the ranking. 

 

To setup a table like the one above where only the selected Campaign in the Optional was displayed do 

as the following: 

1. Add Campaign as an Optional Filter 

2. Add all the Campaign as Columns (or rows) in the table object  

3. Exclude the Campaign filter from the object in the Filter/Optional Filter panel 

http://www.dapresy.com/
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4. In the Rank setup enable “Show rank for a specific item based on Optional Filter selection” and 

select the Campaign Filter in the “Select optional filter item” 

If step number 3 above is not made the ranking will be based on the selected campaigns only and not all 

campaigns. This can be useful in use cases where the user can do multi selection in the campaign filter 

and wants to rank the selected campaigns to each other and not rank among all campaigns. 

The same logic as described above can also be applied to Variable subsets. 

For Hierarchical filters make sure that all the hierarchical filter groups that shall be used as base for 

ranking is shown in the table, that is done through the “Hierarchical group settings” in the Filter panel.  

 

4.1.2 Rank logic 

The rank is based on all decimals, rounded values are not used to calculate the rank. If two or more 

items have the same result they will get a shared rank. 

 

4.2 Merging series by row headers 

When using multiple series in a Storyteller table discrete series can now be merged by matching the row 

headers which vastly increases the flexibility of the table design. 

Below is an example shown where the table shows the % value from last week, the difference to 

previous week and the rank, all in separate columns. The table has been built by selecting three series 

(three tables) and these have been merged by the row headers which was not possible until now. 

 

http://www.dapresy.com/


 

www.dapresy.com  Technical Release Notes Dapresy Pro 2018 January-February Release Page 15 of 42 

 

4.2.1 Setup 

The tables are merged by the Row headers by applying the new setting “Match series on row text”. The 

setting uses the same logic as the already existing function “Match series on column text”. 

The image below shows the new setting for merging series on row text.  

 

 

Note 1: the settings “Match on column text” and “Match on row text” cannot be used simultaneously. 

Note 2: the Row texts in the sub series must be identical with the main series, if not the series will not 

be merged. 

Note 3: the sort order of row headers in the subs series do not need to be identical with the sort order 

of the row headers in the Main series, the rows in the sub series will be arranged automatically to match 

the Main series.  

 

4.3 Setup Formatting Rules Per Series 

The Formatting rules can now be set per series which increases the flexibility of highlighting values in 

tables when different columns shows different data or when the columns shall have different threshold 

values.  

In the example below, different formatting rules have been applied to the Rank and the Diff column. 

This was not possible before as all series in the table shared the Formatting rule settings.  

The image below shows a table using different Formatting rules in the Diff and the Rank column. 
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4.3.1 Setup 

The Formatting rules could previously only be setup in the Main series and these were applied to all the 

Sub series in the table object.  With the new setting you can choose if the Formatting rules from the 

Main series shall be applied to a Sub series or not. If you select to not use the Formatting rules from the 

Main series you can setup new rules that are only applied to that sub series. 

By default a Sub series uses the Formatting rules from the Main series so the default behavior has not 

been changed. 

The image below shows the new Formatting rule option in a Sub series. If the check box is ticked the 

Formatting rules from the Main series are applied, if the check box is un-ticked specific Formatting rules 

can be setup that only are applied to the current Sub series. 
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4.4 Set interval and Moving Averages Per Series 

Previously all series in the Storyteller table object shared the same interval and same moving average 

settings, these settings are now set per series.  

This new logic, together with the new ability to match series by row text, makes it, for example, possible 

to create a table with different intervals as shown below. The table shows weeks, months and years in 

columns. 

The image below shows a table with different intervals in columns. 

 

 

4.4.1 Setup 

The Interval and moving average settings were previously only available in the Main series but these 

settings are now available also in the Sub series as shown in the image below.  

The image below shows the Interval and Moving average settings in a Sub series. 
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4.5 Custom Row and Column Headers 

The row and column headers in Storyteller tables can now be customized which gives much more 

flexibility in layout as the labels can be abbreviated or changed entirely to fit the reporting needs. 

Like before the default headers come from the question, answer, filter or the interval labels but these 

can now be replaced, here are two examples. 

Example 1: Custom headers have been used to shorten the Question texts in column headers, the table to 

the left shows the original headers and the table to the right the result with custom headers. 

 

 

Example 2: Custom headers have been used to replace the Question texts in column headers with 

Percentage and Rank headers.

. 

Note: the custom labels are connected to a specific row and column number and not to a specific item 

like a question text or an answer text. So these custom headers should only be used when the order of 

the columns is fixed. As an example, the column headers cannot be replaced if the order of the columns 

changes due to, for instance, Optional filtering applied by report users. 
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4.5.1 Setup 

The custom row and column headers are defined in the Text panel in the Setting tab. To add custom row 

or column headers do as the following; 

 Enable the function 

 Add the custom header 

 Select if the custom header should replace the original header or be added as prefix/suffix 

 Select the nesting level (see explanation further below) 

 Select the column/row number 

The image below shows the new controls. 
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Below you see an example where both the column and row headers have been adjusted. 

 

 

The image below shows the nesting levels. 
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Note 1: the custom defined column headers are static and connected to the defined column number (starting from 

the left with 1 being the first column, 2 the second, etc.), the headers are not connected to a specific item such as 

a question, answer or filter compare option.   

Note 2: the custom defined row headers are static and connected to the defined row number (starting from the 

top with 1 being the first row, 2 the second, etc.), the headers are not connected to a specific item such as a 

question, answer or filter compare option.   

The header texts must be enabled as the user defined header overwrites the standard header text. 

 

4.6 Layout updates - Minimum Column Width 

A minimum column width setting has been added which makes it easier to control the width of the 

columns. By using the setting it is easier to get the same width for all columns and it is easier to align 

multiple tables above/below each other. 

The top table below uses the Minimum column width setting. The minimum width is set to 100 pixels and 

the row header to 150 pixels, by setting the object to 950 pixels wide the columns get a width of 100 

pixels. The lower table shows the result if a minimum column width is not used, as shown the width of 

the columns differ due to the length of the labels.   

 

4.6.1 Setup 

The new controls for setting a minimum column width is available in the Layout tab in the General panel 

as shown in the image below. To enter a minimum column width, untick the Auto option and enter the 

desired minimum column width in pixels. 

The image below shows the new controls for minimum column width. 
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Note: The columns will be wider than the defined minimum width if the text does not fit in the cell. An 

option for setting fixed column width will be implemented in a future version. 

 

4.7 Layout updates - Vertical Text Alignment 

A new setting for defining the vertical text alignment has been added to the table layout settings which 

allows you to, for example, align the column headers top, centered or bottom. 

Below three different table examples are shown. Each table uses a different vertical alignment in the 

column headers. 

 

4.7.1 Setup 

The new control for vertical text alignment is available in the Layout tab in the following panels: 
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 General 

 Row Headers 

 Column Headers 

The default value is Center so the default behavior has not been changed. 

The image below shows the new control for vertical text alignment in the Column header panel. 

 

 

4.8 New Hierarchical filter option to show all groups in the same level 

In Projects using Hierarchical filters you can select which groups to be shown in the table based on the 

group selected by the user, as an example the table can show the selected group plus the parent group 

and the Total and so on. 

A new comparison option has been added named “All groups in selected level”. This option is perfect to 

use when, for instance, creating top lists, ranking etc. as the benchmarks are very often calculated 

against all the groups in the same level of the hierarchy. 

Example: if the Hierarchical structure looks like the image below and the new option is applied all the 

cities will be displayed in the table if the user selects any of the cities. If the user instead selects any of 

the countries all the countries will be displayed in the table. 
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The image below shows the Hierarchical filter structure that the example above refers to. 

 

4.8.1 Setup 

The new option is located among all other Comparison group options in the Hierarchical Group Settings 

panel, see image below. 

The image below shows the new option for showing all groups in the selected level. 
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5 – Storyteller chart improvements 
The following improvements have been done in the Storyteller charts:  

 Improved Solid Gauges when negative scale is used 

 Ability to turn the Magnifying glass on and off 

 New ability to set the Time interval and Moving average per series 

 New Hierarchical filter option to show all groups  in the same level 

 

5.1 Improved Solid Gauges When Negative Scale Is Used 

When a Gauge shows the NPS values the scale is usually set to -100 to 100. The default behavior of the 

Solid Gauge is to start from the lowest point (-100) and go to the actual result (see image further down).   

In many cases the required behavior is to start from 0 instead of -100. This can now be achieved by using 

the Threshold value function, with this function you can set the start point to 0, see examples below. 

The gauges to the right show the new ability to use 0 as the starting, the gauges to the left shows the old 

behavior. 

 

 

5.1.1 Setup 

The already existing Threshold value is used to set the starting point to 0 so it is used for both defining 

the starting point and to color the series based on result.  

The image below shows the Threshold value controls. Set the Threshold to 0 and the series will start from 

0 and not from the minimum scale value. 
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Note: This is only effecting newly created Solid gauges. In already existing Solid gauges the starting point 

will still be the minimum scale. This logic is needed in case of an already existing Solid gauge used the 

function to color the series. 

 

5.2 Ability to Hide the Magnifying glass 

The Magnifying glass in charts, used to enlarge the chart, was earlier always shown but now you have 

the ability to decide if it will be shown for report users or not depending on the use case.  

The image below shows the Magnifying glass, this can now be turned off so it does not show up on hover 

over. 
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5.2.1 Setup 

The Magnifying glass is turned on/off in the Tooltip panel as shown in the image below. The setting is 

Off by default in all newly created charts. 

The image below shows the new control for turning the Magnifying glass on and off. 

 

 

5.3 Set Interval and Moving Averages Per Series 

Previously all series in a Storyteller chart used the same interval and same moving average settings but 

this logic has now been improved so these can be set per series.  

With this new logic you can for example create a trend chart showing both the moving average result 

and the actual result in the same chart as shown in the image below. 

The image below shows a chart which shows both the moving average and the actual result per week. 

This can now be achieved as interval and moving average settings are defined per series. 
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5.3.1 Setup 

The Interval and Moving average settings were previously only available in the Main series but these 

settings are now available also in the Sub series as shown in the image below.  

The image below shows the Interval and Moving average settings in a Sub series. 

  

5.4 New padding setting in Data labels  

The data labels in charts have previously had a 5 pixel padding (padding= the distance between the 

bar/line and the data label) for a use of white space which gives a light, uncluttered appearance. The 

padding value can now be changed and the padding has been removed completely in stacked bar and 

column charts.  

As the stacked bar/column charts use 0 pixel padding the data labels are shown even in smaller parts of 

the chart as shown in the example image below. 

The image below shows the difference in stacked bars/columns chart. The top chart shows the old 

behavior and the bottom chart shows the new, as shown the bottom chart show the data label in even 

smaller parts as the padding around the data label is removed. This logic is automatically applied in all 

stacked and full stacked  bar and column charts so no setting needs to be turned on. Next chapter 

describes how you can adjust the padding in other chart types. 
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Note: if the Data labels are still not shown due to lack of space try to use a smaller font size or make the 

chart area slightly bigger. 

5.4.1 Setup 

To change the padding for the Data values use the new padding setting which can be found in the Data 

label section in the Layout tab as shown in the image below. The images further down show an example 

of a line chart with different padding values applied.  

The image below shows where to find the new padding setting. Note, the setting is not shown for 

stacked/full stacked bars and columns as these charts use zero padding by default. 

 

http://www.dapresy.com/


 

www.dapresy.com  Technical Release Notes Dapresy Pro 2018 January-February Release Page 30 of 42 

 

The top line chart below uses 5 pixels padding which is the default value. By setting the padding to 0 

pixels the chart will look like the second image below: as shown the data values are displayed closer to 

the line which might be better in cases of having many lines as it is easier to see which value belongs to 

each data point. 

 

 

5.5 New Hierarchical filter option to show all groups in the same level 

In projects using Hierarchical filters you can select which groups to be shown in the chart based on the 

group selected by the user, as an example the chart can show the selected group plus the parent group 

and the Total and so on. 

A new comparison option has been added named “All groups in selected level”. This option is great to 

use when, for example, creating top lists, ranking etc. as the benchmark is very often made against all 

the groups in the same level of the hierarchy. 

Example: if the Hierarchical structure looks like the image below and the new option is applied all the 

cities will be displayed in the chart if the user selects any of the cities. If the user instead selects any of 

the countries all the countries will be displayed in the chart. 
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The image below shows the Hierarchical filter structure that the example above refers to. 

 

5.5.1 Setup 

The new option is located among all the other Comparison group options in the Hierarchical Group 

Settings panel, see image below. 

The image below shows the new option for showing all groups in the selected level. 
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6 Respondent Data Table 
The following improvements have been done in the Storyteller Respondent Data table:  

 New support for displaying photos, links etc. 

 Ability to turn the Excel export and Full Screen mode off 

 Ability to set vertical text alignment 

 

6.1 Support for displaying photos etc. in Respondent data tables 

In some projects, like for example a Mystery shopping project, the respondents take photos in the 

survey to show deviations. These photos are often included in the data file as links (URLs) to the actual 

photos. With the newly developed function “Web variables” these photos can now be shown as 

thumbnails instead of links in the Respondent data table. The thumbnails of the photos are shown both 

online and in exports. 

The image below shows an example of how photos can be displayed in the Respondent data table. Each 

photo is present as a URL in the data file. 

 

The photos are also clickable, when the user clicks a photo the original photo is opened in a separate 

browser tab. 

 

6.1.1 Setup 

Before setting up the Respondent data table make sure that the URLs to the photos are present in the 

imported data, these should be stored in an Open ended variable. 

In the Respondent data table you will find the new Web Variables function in the Settings tab as shown 

in the image further down.  Currently the Web variables function supports to show thumbnails of 

photos or Links to the photos.  
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The image below shows the difference between the Link and Thumbnail option. 

 

 

The image below shows the new interface for defining the web variables. 
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To setup a table with web variables do the following: 

 Create a Respondent data table and select the variables to be shown, the variable holding the 

links to the photos must be one of the selected variables 

 In the new Web variables panel select, in the Variable dropdown list,  which of the variables 

that holds the links  

 In the Type list select if the link should be shown as a Thumbnail (only applicable when the link 

goes to an image file) or if the URL will rendered as a clickable link  

o If the Thumbnail option is used the size of the thumbnail to be shown in the table has to 

be defined.  

o 50 pixels is the default value.  

o The value is applied to the height of the thumbnail, images are scaled retaining the 

original aspect ratio. 

o If the Link option is used the link text can be defined and that will be displayed instead 

of the URL, if no link text is defined the actual URL will be shown. 

 

6.1.2 Exports 

The thumbnails are included in the exports to PDF, PPT and to Excel. The thumbnails are not clickable 

links in the exported files. 

Note: The generation of an Excel file with many of photos will take time because hundreds or even 

thousands of photos need to be inserted in the Excel file. The exports to PPT and PDF are not affected by 

longer generation times as these only contain an screenshot of the Respondent Data table as it is shown 

on screen (not all the respondents/photos are included in these exports, only those visible in the 

browser). 

 

6.2 Ability to Turn the Excel Export and Full Screen Mode Off 

A new setting has been added to the Respondent Data table which allows the administrator to turn the 

Excel export and the Full screen mode off which is particularly useful when the table will only show a 

limited amount of data.  

The image below shows the Options menu that now can be turned off. 
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6.2.1 Setup 

The Excel export and the Full screen mode are turned on and off separately. Both are turned on by 

default so the default behavior has not been changed.  You find both the new settings in the Table 

settings panel. 

The image below shows the new settings in the Table Setting panel, use these to turn the Excel export 

and Full screen mode on and off. 

 

 

6.3 Vertical text alignment 

A new setting for defining the vertical text alignment has been added to the table layout settings which 

allows you to align the text vertically (top, centered or bottom). 
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6.3.1 Setup 

The new controls for vertical text alignment is available in the Layout tab in the following panels: 

 General 

 First Row 

 First Column 

The default value is Center so the default behavior has not been changed. 

The image below shows the new control for vertical text alignment in the First Row panel. 
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7 Storyteller setup  
 

7.1 Arrange, Distribute and Align object Groups  

The positioning functions Distribute, Arrange and Align can now be applied to both Groups and 

individual objects (previously these positioning functions where not supporting Groups). The new 

support makes it easier and more efficient to position the Groups in the dashboard/report. 

Below you see an example of 3 Groups, these can now easily be aligned and distributed vertically to get 

the layout shown in the second image below. 

 

7.2 Arrange slides 

The slides can now be arranged in the slide navigation tool using drag and drop which makes it much 

easier to arrange the slides. 

The image below shows how the slides can be arranged by drag and drop in the slide navigation menu. 

 

 

Note: The slides can only be arranged in Setup mode and not in Preview mode.  

http://www.dapresy.com/


 

www.dapresy.com  Technical Release Notes Dapresy Pro 2018 January-February Release Page 38 of 42 

 

8 – Significance test improvements - Effective base size 
A new option for using the “Effective base size” has been added to the “Two independent sample Z test” 

calculations in the Storyteller charts and tables and the Cross table tool. 

The table below shows an example where the Two independent sample Z test uses the effective base 

size in the significance test calculation. Each week is tested against the previous week, the cell 

background indicates if the change is significant or not.  

The image below shows an example table with a significance test applied which uses the effective base 

size. 

 

 

8.1 Setup 

To apply the effective base size to a significance test calculation select that option in the existing Base 

size list, see images below. The option is only available if the calculation is based on weighted data. 

The image below shows the new Effective base size option in the Base size list in a Storyteller chart and 

table 
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The image below shows the new Effective base size option in the Base size list in a Cross table tool 2.0 

 

In the Cross table tool 2.0 it is possible, in the setup, to define if the new option shall be shown in the 

Cross table tool or not, see image below. 

The image below shows the setup of the Cross table tool 2.0. If the “Effective base size” option is ticked it 

will be displayed for the users. 

 

 

8.2 Formulas 

The effective base size is calculated as below; 
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 Effective base = the squared sum of weights divided by the sum of squared weights 

 

Formula for Two independent sample Z test – Proportions  

This is the formula used for calculating the “Two independent sample Z test” for proportions. The yellow 

highlighted base sizes use the effective base instead of the weighted base size when the new option is 

applied. 

 

 

 

Formula for Two independent sample Z test – Means 

This is the formula used for calculating the “Two independent sample Z test” for mean values. The 

yellow highlighted base sizes use the effective base instead of the weighted base size when the new 

option is applied. 
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9 Template library improvements 
The chart wizard has been improved for simplifying the creation of the charts, a few layout options have 

been added to the Preview step as shown below. With these new settings it easier to adapt the 

template chart to the needs of the current project. 

The image below shows the Preview step, as shown some of the layout setting can now be updated from 

this step to avoid having to enter the All settings tab for doing minor layout changes. 

 

Similar layout settings will later on be added to other template objects like for example tables. 
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10 Respondent based Event server 

10.1 Limiting number of alerts in the Respondent based Event emails 

The Respondent based Event emails are either sent out as one email per alert or as one email containing 

all alerts. If the latter option is used it is now possible to limit the number of alerts to be included in the 

email. If the setting is used the email is more of a “preview” of new alerts, the user then has to login to 

the portal to see the full list of all new alerts. 

10.1.1 Setup 

The image below shows the new setting to be used if the number of alerts in the email is to be limited. If 

the new setting is disabled all alerts will be included in the email. 
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